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Airfield Lights Toolbox (or AFLT for short) is a comprehensive utility for the creation of 
custom airfield lights for Microsoft Flight Simulator and Lockheed Martin Prepare3D 
(collectively referred to as "FlightSim") airports.  AFLT includes typical 3D models for the 
usual airfield light fixtures and approach lighting structures from which you should be 
able to create just about any airfield light arrangement.  Where the stock models are not 
sufficient for your purposes, you may replace or supplement them with your own. 
 
Illumination of the models may be, depending on the FS version in use, either 
BGL_LIGHTS, standard effects, inversely-mipmapped effects or 3-plane lights that grow 
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in size as the user aircraft gets further away (LOD-variable), thus extending their visible 
range.  
 
For FS9 and FSX, both the 3D models and the corresponding lights are implemented as 
scenery.  Unfortunately, with P3Dv2, Lockheed Martin discontinued support for certain 
legacy technologies, necessitating the use of SImconnect-controlled “simobjects” for 
lights whose characteristics are more complex than simply off in the daytime and on at 
other times.  However, for FPS-efficiency purposes, only the AFLT light sources are 
controlled with Simconnect; the 3D models are still placed as standard scenery items.  
AFLT will also optionally display user-specified images on the ground when a light itself 
(not the associated 3D model) is specified to be on the surface (e.g., centerline lights). 
 
This version of AFLT introduces a powerful graphical interface.  “Point” AFLT to either an 
.xml or .bgl file containing an airport definition and an image of the runways, taxiways, 
aprons and associated lighting will appear.  
 
Characteristics of edge and or centerline lighting for each taxiway and runway are 
specified using simple dialogs.  AFLT automatically configures all standard approach 
and PAPI/VASI configurations, or you can create your own.  Practically every parameter 
is adjustable, but if you are happy with the defaults, configuring any approach – even 
ALSF-2 or Calvert-2 – requires but a single mouse click.  Or, if you are in a hurry, AFLT 
will, with only a few mouse clicks, configure the lighting for an entire airport based on the 
existing Flightsim data.  It doesn’t get any better than this! 
 
For simplicity, references in this manual to FSX apply equally to FSX, FSX-SE and 
P3Dv1.  The term “P3D” includes P3Dv3 and later versions.  P3Dv2 has “difficulties” that 
preclude use of AFLT custom lighting. 

1.  INSTALLING, EXECUTING and UNINSTALLING AFLT 

Compatibility – Data created with AFLT2 or AFLT3 is not directly compatible with this 
version.  However, you are able to import data from those earlier versions. 
 
Installation (All Versions) - AFLT does not affect the system registry.  To install, simply 
copy the files and folders from the downloaded archive into a new folder of your choice 
(referred to as “the AFLT folder).  Do not attempt to update an AFLT2 or AFLT3 
installation with AFLT4.  If you have previously generated AFLT2 or AFLT3 lights 
that you wish to display alongside any AFLT4 lights you may generate, please 
refer to the last paragraph of the section of this manual entitled Creating a Library 
of Elements. 
 
AFLT is a Microsoft NET.Framework 4.5 application.  If NET.Framework 4.5 or later is 
not already installed on your computer, the “redistributable” can be downloaded from the 
Microsoft website at no charge. 
 
Settings – To get the full benefit of AFLT’s inverse-mipmapped effects, the following 
sliders under FlightSim’s Options/Settings/Display should be set as follows (i.e., hard 
right): 

 Scenery/Special effects detail: High 
 Hardware/MIP mapping quality: 8 
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 Hardware/Hardware-rendered lights: 8 
 Hardware/Global max texture size: Massive 

 
Execution – To execute AFLT, double-click on AFLT.exe, or create a desktop shortcut to 
that file.  To avoid “privilege” exceptions, AFLT installs with “Run as administrator” 
privileges.  Consequently, the UAC will require confirmation each time you run AFLT. 
 
Windows 7 users may wish to run AFLT in the XP compatibility mode.  Running it 
otherwise may result in a "this program may not have installed correctly" message when 
AFLT is shut-down.  Despite the error message, there is no known problem - other than 
the annoyance factor. 
 
Initialization - When you shut-down AFLT for the first time, an additional file, AFLT.ini, is 
created and saved to the AFLT folder.  AFLT "remembers" key settings from one 
session to the next in this file.  The next time you run AFLT, those settings are restored. 
 
FSX DX10 Preview Mode – AFLT is generally compatible with FSX DX10 Preview Mode 
– with one exception.  When you pan around the airfield or approach from different 
directions, whole blocks of custom lights disappear and, eventually, re-appear.  This is a 
known deficiency of FSX DX10 Preview Mode and affects several types of lights.  To 
correct, this you must have the applicable …_LightField.bgl from Steve Parson’s DX10 
Fixer in the \scenery folder to which you save the AFLT lights and his fx_dx10field.fx 
effect in your Effects folder.  Note that when you uninstall the DX10 Fixer libraries, that 
effect is deleted from the Effects folder, so you may have to replace it. 
 
Alternately, use effects with FS9 models when in DX10 Preview Mode. 
 
Automatic Updates - Whenever AFLT is started, it optionally checks the support server 
to determine if a more recent release is available.  If so, AFLT will download that release 
for you. The updated release must be manually installed in the normal manner (except, 
of course, you may overwrite the earlier version). 
   
Un-Installation - To uninstall AFLT, delete: 

 the AFLT folder and all its contents, and 
 any effects whose name starts with “fx_AFLT4_” from your Effects folder(s),   
 for P3D, remove the AFLT for P3D folder from Documents\Prepar3d v_ Add-ons,  
 any “purged” .bgls you may have saved to scenery folders (see section entitled 

Purge Airport Stock Data Function), any 
 any other AFLT files (names start with “AFLT_”) from relevant scenery folders. 

2. AFLT STOCK FILES 

Airfields Lights Toolbox comes with everything you'll need to start creating all the usual 
airfield lighting elements.   

 a set of 3D base models for each of FS9 and FSX (FSX models are used for P3D 
and associated textures for the following fixtures are included: 

o runway/ taxiway edge lights (“Edge”) 

o split light for runway thresholds (“Split”) 

o ground- and tower-mounted strobe lights (“Strobe”, “Strobe_T”) 
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o approach lighting structures and approach lamps(“Approach_T”, 
“Approach”) 

o hold-short warning lights (“Wigwag”) 

o PAPI/VASIs  (“PAPI_VASI”), and 

o dual-headed obstruction lights (“Obstruction”) 

o aeronautical beacons; flashes red continually and, optionally, strobes 
during the daytime while flashing red at night. (“Beacon_T”) 

The names in parenthesis are the formal names used in AFLT.  The Edge and 
Strobe models may be used in both uni- and omni-directional applications.  
(Approach lights are always uni-directional.)  The 3D model files (.mdl), together 
with their textures, are saved in AFLT's BaseModels folder.  Each model is more 
fully described in Appendix "A". 

 a set of 2D images to be displayed when a light is to be at ground level, also 
described in Appendix "A". 

 BaseModels.txt - a tabular text file specifying for each base model the function it 
serves and the offset from the base model’s reference point of the attachment 
point for the light(s).  Its format is described in Appendix "A".  If you replace or 
add a base model, you'll have to update/make a corresponding entry in this file 
before you will be able to use it. 

 Colors.txt - a tabular text file specifying, among other things, the RGB value for 
each color available for use and the position of that color on the texture 
obj_AF_Lights in its various configurations.  BGL_LIGHT color, effect color and 
the color of the model's light lens are controlled by this file.  The format is 
described in detail in Appendix “B”.  You may add up to three of your own colors 
or edit any of existing ones.  

 Lights.txt - a tabular text file specifying for each light type the base model file to 
be used and its directional and visibility characteristics – including the size of the 
related effects.  Its format is described in Appendix "C".  If you add any base 
models, you'll also have to make corresponding entries in Lights.txt before you 
will be able to use them.  

 Import.txt – cross-reference material supporting the import of AFT2 and AFLT3 
project data.  You will have no need to change this file. 

 Standards.txt – a tabular text file specifying for each ground-illuminating 
standard, the 3D model to be used, the associated illumination texture files and 
the characteristics of the individual light heads.  Each model is more fully 
described in Appendix "F". 

3. PROJECTS 

AFLT is project-oriented.  Each project must have a unique identifier (project ID).  
Project IDs may be any character string.  But, since the related files generated by AFLT 
will be prefaced with “AFLT_projectID_”, you’ll want to keep it short – perhaps the ICAO 
or IATA code for the airport.   
 
When you create a project, you’ll first be asked to specify a project ID.  Then, the 
Preferences dialog opens, allowing you to select the dimensional units you plan to use 
for the project.  (You may change the selected units at any time later).  Once that’s done, 
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an “open files” dialog will appear.  Navigate to the .xml or .bgl file containing the 
definition of the airport of interest (“airport reference file”) and click Open.   If the airport 
has been compiled with ADE’s FS9 complex split option, designate the base airport file. 
You should not choose the copy of the airport .bgl in the scenery folder since, if 
you do, you will be unable to “purge” it later.  Instead, make a copy of the 
“scenery” .bgl, move it elsewhere and use the copy as your reference file. 
 
Countries using the metric dimensional system generally use approach centerline light 
spacing of 30 or 60 m. (depending on the approach system) whereas those using the 
British dimensional system will typically use 100 or 200 feet instead.  ICAO specifies the 
Calvert system using metric whereas the FAA specifies AFLS2, for example, in feet.  But 
if the AFLT2 system is use in a metric country, a centerline spacing of 30m. may be 
used instead of 100’.  So, direct conversion (i.e., using 3.28 ft/m) of the specifications 
may not be appropriate.  For example, 30m. converts directly to 98.4’. But, in the other 
direction, 100ft converts to 30.49m. – a factor of 1/3.  For convenience, PAPI and VASI 
parameters are specified internally in the British system. 
 
AFLT allows you to program lighting systems in either ft. or m. and to switch between 
systems.  If you have selected feet as your distance units, centerline spacing of ICAO 
systems will be converted to multiples of 100’.  If, instead, you have selected meters, 
centerline spacing of FAA systems will be converted to multiples of 30m.  Other 
parameters, including those for PAPIs and VASs which are specified internally in the 
British system, are handled similarly.   
 
You may inhibit this behaviour by checking the Inhibit Interchange checkbox on the 
Preferences dialog – in which case 3.28 ft/m will be used for all conversions.. 
 
You can switch dimensional system at any time. Unless you have directed otherwise, 
conversions are as described above.  Consequently, should you save the converted 
parameters, some light positions on the AFLT display may shift slightly because in doing 
so, you have actually changed their physical location.   
 
It is expected you will use the same dimensional system for all actions affecting a given 
airport.  So, conversion will not be a frequent occurrence once your project has been 
fully specified.  But, where conversion has occurred, you should carefully check all 
parameters.  AFLT’s methodology may not properly handle every instance. That being 
said, the difference between the two factors is only about 1%, so an uncorrected 
conversion is not likely to be noticeable in the finished product. 
 
The AFLT folder contains a folder named “Projects”.  All project data is saved in sub-
folders named as the Project ID, including 3D .mdl files, associated textures, object 
libraries and placement data.   
 
For FS9 and FSX, AFLT will optionally copy the object libraries it creates and textures to 
another folder of your choice – the Scenery Folder.  If used, the folder’s path is entered 
on the Make Library dialog.  Normally, the Scenery Folder would be the folder containing 
the airport’s \scenery folder as specified in the Scenery Library and its associated 
\texture folder.  But, you can have the object libraries and textures saved to any location.  
For P3D, AFLT saves all files in the folder Documents\Prepar3d v_ Add-ons\ AFLT for 
P3D - even if you create custom lighting for more than one airport. 
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4. QUICK START 

The first time you start AFLT, a blank drawing surface with a menu bar appears.  Click 
Create New Project (Project menu).  Enter a Project ID and select the dimensional units 
you intend to use. Then, navigate to the file you intend for the airport reference file.  If 
there are no error messages, you should see an image of the airport showing runways, 
taxiways and aprons – and lighting based on the stock lighting specified in the airport 
reference.  (Note, the positions of the lights will not match the positions of the stock 
lighting in FlightSim.  AFLT uses a proprietary algorithm to place lights to better reflect 
the real-world.)    
 
The custom lighting you see will have been generated with default parameters.  Should 
this not reflect real-world conditions at that airport, select Default Parameters for This 
Airport (Options menu) and make any necessary changes.  These changes will be 
applied and the display regenerated using them immediately upon closing the dialog.  
These default parameters (whether edited or not) are saved with each airport and will be 
automatically invoked whenever the airport project is loaded.   
 
Move the mouse over a runway or taxiway (it turns orange) and left click (it turns red, i.e. 
selected).  Right-clicking anywhere on the drawing surface brings up a context menu.  
Select the desired operation from the context menu and “fill in the blanks” on the light-
specification dialog that appears.  When you close that dialog, the lights you have 
specified will appear on the drawing surface connected by one or more narrow lines.  
You can change or delete any programmed lighting by selecting the airport surface, 
lighting strip or light element of concern, right-clicking and selecting from the context 
menu.   
 
You may wish to exclude some or all of the stock lighting in your project.  To do so, load 
the airport and delete all the lighting you don’t want to include.  To delete all stock 
lighting clear the screen with Projects/Clear Placement Data.  Then, Save Placement 
Data.  This will create a Placement.xml file which will prevent the unwanted stock data 
from appearing on subsequent startups of AFLT. (If a project unexpectedly starts-up with 
a blank screen, perhaps you have an empty Placements.xml file in the Project folder.) 
 
Should you delete some stock data you really wish to customize, it’s easy to retrieve.  
The bottom item in most of the context menus is “Use Stock Lighting”.  Select it and the 
all “stock” lighting will be displayed over the airport image.  A small dialog will also 
appear in which you can select from “stock” lighting in a variety of ways.  Click Apply 
after each selection.  When you close the dialog, the stock lighting will be replaced by 
your currently programmed lights plus whatever “stock” lighting you selected.  You may 
view the “stock” lighting at any time by clicking on the Stock Data in the View menu.  But, 
to adopt stock lighting, you must use the context menu. 
 
If you wish to supplement your project with data from an earlier AFLT2/3 project, click 
Import AFLT2/3 Project Data under the Project menu.  You will be invited to locate your 
AFLT2/3 Library Folder after which a small dialog will appear.  Click the Import File 
button and navigate to the project file (.bgl, .xml or .def) to be imported.  The main 
display will be updated with each file.  Close the dialog when finished. 
 
Once you have implemented the desired lighting plan (or at any other time), click Save 
Placement Data (Project menu).  Each time thereafter this airport project is loaded, the 
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last-saved lighting data will be displayed.  (The airport image is always derived from the 
reference airport file.  At each startup, AFLT will automatically display the airport “stock” 
lighting adjusted as reflect lighting as was last saved. 
 
To create the object libraries, click Compile Data (Project menu).  The Make Library 
dialog will appear.  Select the Flightsim version to which the object libraries will apply, 
specify the Scenery Folder (not for P3D), select the desired general characteristics of 
the lighting and click Create/Save Library.  A message will pop up telling you where 
AFLT will save the library.  (You can abort at that stage if it not where you want the files 
placed.)  Then, you’ll see some windows flash on and off your screen (the compiler at 
work) and, finally, a message confirming that the library has been generated. 
 
Run Flightsim.  Voila!  Your lighting appears.  But, any stock data in the airport .bgl also 
appears.  Use AFLT’s Purge Airport Stock Data function or edit the airport .bgl file (using 
ADE or another airport editor) to remove the stock lighting.   
 
Your satisfaction with the custom lighting created will likely depend on your 
knowledge of the full capability of AFLT and your use of some of the additional 
features.  Consequently, it is strongly recommended you read this manual from 
cover to cover, especially the section on SIMOBJECTS if you are creating lighting 
for use in P3D.   

5. GRAPHICAL USER INTERFACE 

Following is an overview of the operation of the graphical interface, which displays the 
runways, taxiways and aprons of the selected airport and associated custom lighting.   

 
Displaced thresholds are indicated by a series of Vs on the displaced side.  Taxiways 
are divided into segments comprising contiguous links not interrupted by a crossing 
taxiway or runway.  Where necessary, links within a segment have been re-oriented so 
as to all point in the same general direction, i.e., the end of one link is the start of its 
immediate neighbour in the same taxiway.   
 
When you move the mouse cursor over one of the airport surfaces, that surface will turn 
orange.  Orange implies “captured”. Moving the cursor over an individual light results in 
an orange circle around the light.  Associated lights (e.g., runway edge lights) are 
connected on the display by a narrow line.  Placing the cursor on that line causes the 
line to turn orange.  As well, if you have selected the optional tooltips, a summary of the 
surface/light/line characteristics is shown.   
 
For convenience, when the cursor is over a runway, a chevron is drawn at the primary 
end.  When the cursor hovers over a taxiway the direction of the link under the cursor is 
indicated by a chevron.   
 
Left-clicking on an orange surface, light (except members of arrays such as runway end 
lights, approach lights or PAPI/VASIs) or line selects (i.e., it turns red) that element for 
the subsequent operation.  A single click on a taxiway link selects that link.  Once a 
lighting or surface element is selected, a right-click anywhere on the screen brings a 
context menu into view listing the functions available for that element. To place an 
independent light or line of lights left-click anywhere other than an airport surface (to 
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deselect any selected surfaces or elements) and then right-click at the point where the 
light is to appear or the line is to start.   
 
For runways, the context menu functions allow you to add, edit or replace each type of 
associated lighting individually, e.g., edge lights, approach lights, etc. or to delete same.  
For taxiways, the only unique variable is the left/center/right specification.  All other 
taxiway lighting parameters are global and specified using Default Lighting Parameters 
(Options menu). For lines of lights, you can delete all members of the line or insert a new 
member.  You can create, edit and delete individual lights.   
 
Some of the element creation/editing dialogs may require positioning information.  The 
location where the mouse-click selecting the context menu function occurred is retained 
for use in such dialogs.  Most dialogs that uses positioning information will also accept 
user aircraft position instead if Flightsim is running. 
 
Generally, light-specification dialogs open with only a single or a few field(s) enabled.  All 
the other fields are disabled (grayed-out).  Once data is entered into the key field(s), one 
or more other fields are enabled – and so on until all fields on the dialog are enabled - 
other than the Place Lights button.   The Place Lights button is only enabled when all 
required data has been entered.  If the Place Lights button is not enabled, there will be 
some textbox or set of checkboxes or radio-buttons that need attention.  For further 
detail on these dialogs, please refer to the relevant section below. 
 
When the Place Lights button is enabled and clicked, the dialog is closed and the 
symbols for the lights reflecting the specification appear on the airport display. 
 
Generally, a line of lights or individual light whether in a line or not may be moved by 
selecting it and “dragging” it with the mouse.   
 
Once you’ve created your custom lighting, click Make Library and select the Flightsim 
version.  If you’ve done all this correctly, your AFLT light elements should be displayed 
the next time you “fly” to the airport of concern.  Don’t forget to disable the corresponding 
lights in your airport definition file.  The Purge Airport Stock Data function (Projects 
menu) will do this for you.)  Otherwise, you’ll have both sets of lights. 

6. OPERATING OVERVIEW 

The starting point for every light created with AFLT (generally referred to as an 
"element"), is a base model, i.e., a 3D model of the light fixture, or support or whatever.  
AFLT provides a set of stock base models (mdl files) and textures for all usual light types 
for both FS9 and FSX.  P3D uses FSX stock base models.  These stock models should 
satisfy most of your requirements.  Each of these models has a single "empty" 
attachpoint, the location of which AFLT uses to position associated lights, whether 
BGL_LIGHTS, effects or LOD-variable lights.  The positions of the lights relative to the 
location of the attachpoint in each base model are defined in BaseModels.txt.   Should 
you add or replace stock base models with your own models, you must make a 
corresponding entry in BaseModels.txt (see Appendix “A”). 
 
Base models are assigned to one of the following “categories”: 

 Edge      General purpose edge light 
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 Split  Displays different colors on the front and back sides 
 Approach Uni-directional approach light head 
 Approach-T Approach-lighting structure with one or more heads  
 Strobe  Fixed-frequency (2 cycles/second) flashing light 
 PAPI-VASI PAPI/VASI applications in a variety of configurations 
 Obstruction (Usually) building-mounted, dual headed red obstruction light 
 Beacon Tower-mounted flashing red light with optional daytime strobe. 
 Standard One of a variety of available ground-illuminating standards 

 
The Edge and Strobe categories may be either omni- or uni-directional.  Their colors and 
intensity are user-specified.  These models as well as Splits may be specified as 
surface-mounted, i.e., the lights are displayed at ground level without the 3D model or 
optionally, with a suitable image on the ground.  
 
Each “category” is expanded into one or more “styles”, primarily to reflect their 
directional and visibility characteristics.  The “style” of each light (or set of lights) is user-
selectable and should allow the creation of representative lights for all usual airfield 
applications.  The file Lights.txt sets out the available light styles (see Appendix “C”).  
Users may add custom light styles by modifying Lights.txt.  Following selection of a light 
style, the user assigns color(s), intensity and other characteristics as applicable. 
 
AFLT supports a full range of pilot-controlled lighting, PCL, through the specification of 
on/off criteria using a system global variable (e.g., a COMS frequency or a transponder 
code) and, where appropriate, airport operating hours.  With FS9 base models, if PCL is 
used during the daytime (for example, in low visibility conditions), in addition to the lights 
being on, the light lens "glow".  (That's what the "day-glo" texture is used for.)  
Unfortunately, for technical reasons, this “glow” capability is not available with FSX or 
P3D models. 
 
When used with P3D v3 or later, AFLT’s custom lights will turn on automatically in low 
visibility. 
 
AFLT allows the user to select from four light sources at compile time: 

 BGL_LIGHTS (not available for P3D) 
 standard effects 
 inversely-mipmapped effects   
 variable-size, 3-plane models, referred to as “LOD-Variable” (P3D only) 

The characteristics of each is described in Appendix “D” 
 
AFLT does not actually attach the lights to the 3D model with which they are associated.  
The 3D models are all compiled and saved as scenery.  The separate .mdl files for the 
lights are created on-the-fly and positioned in accordance with the location of the 
attachpoint of their respective 3D model and the data in BaseModels.txt.  Lights with 
identical on/off status, e.g., runway edge lights, are grouped and controlled by a single 
process.  This, together with the separation of lights from the 3D models results in a 
significant reduction in FPS impact over earlier versions of AFLT, especially in P3D 
which would otherwise require each individual light to be a simobject. 
 
Like any other scenery, in order to be rendered by Flightsim, the elements (other than 
simobjects) must be collected in an object library file.  For Flightsim versions prior to 
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P3D v3, AFLT optionally copies the object libraries and textures to the \scenery and 
\texture subfolders of the airport with which they are to be used (as specified in the 
Scenery Folder field of the Make Library dialog).  For P3D v3 and later, AFLT creates (or 
adds to) a P3D Add-on Package (folder) and places that Add-on Package, named AFLT 
for P3D, in the appropriate Documents\Prepar3D v_ Add-ons folder.  For details of a 
P3D Add-on Package, please refer to the Add-ons section of the SDK. 
 
After starting P3D, you’ll notice a new icon in the Windows Task Bar.  That’s the 
SImconnect application controlling the Simobject-based lights.  The associated dialog 
has no use normally, so it is minimized on opening and may stay that way.  It will close 
automatically with P3D.   
 
But, if you click on the icon, you’ll see the dialog below.  It shows which projects 
Simconnect has deployed at that moment, the total number of simobject-based lights 
under control and the number of those lights in transition.  (Deployment of simobjects is 
metered. That is, once within range of an airport or, conversely, having left an airport 
area, the rate at which new lights are deployed and those no longer needed are 
removed is controlled by Simconnect on a light-by light basis, thus avoiding the 
instantaneous initiation or deletion of perhaps several thousand or more lights, a 
situation that would overload Simconnect and impact control of the user aircraft.  As well, 
this dialog facilitates testing of AFLT by allowing an updated set of lights to be compiled 
and installed without stopping P3D.  Once P3D’s startup is complete, the Disconnect 
button will be highlighted.  To “tweak” your lights, click Disconnect, make whatever 
changes are necessary and re-compile the lights.  Then click Reconnect.  The revised 
lights should appear.  
 
 

  
 

Simconnect Dialog 
 

If you open this dialog and close it other than by minimizing, the Simconnect application 
will close and you will lose all your Simconnect-controlled lights. 
 
Please note, any lights that do not require on/off control other than day/night are 
implemented as scenery objects – even in P3D.  The above dialog deals only with the 
Simobject-based lights controlled by Simconnect. 

7. MENUS AND OTHER CONTROLS 

AFLT’s Main Panel is shown below.  It is the primary “working surface”.  It provides: 

 a detailed image of the runways, taxiways and aprons of the airport, 
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 currently-specified lights, 
 menus of the various functions available, 
 display zoom controls (the mouse wheel can also be used for zooming), 
 user aircraft slew controls, and 
 textual display of the geographic cursor position, the geographic size of the 

displayed area and the ground elevation under the user aircraft. 
 

Across the top of this dialog is the main menu bar containing four items 

 Project– creating, opening, importing and compiling data files and for designating 
an airport of interest 

 View – selecting the airport surfaces/characteristics displayed  
 Options – selection of options and display formats, and  
 Help – version information and on-line access to this user manual.  

 
When Flightsim is running, AFLT reports the ground elevation under the user aircraft 
near the upper-right corner of the Main Panel.  The position of the user aircraft is also 
displayed 
 
The Zoom controls are located in the upper right corner of the Main Panel.  Left-clicking 
these buttons will increase or decrease the geographic area displayed by 10%.  If you 
depress and hold-down the left mouse button while over one of these buttons, the 
displayed area will continue to increase or decrease for so long as the mouse button is 
held down.  You may also zoom the display from the mouse-wheel with a 10% change 
per click.  Scroll bars are displayed as necessary. 
 

 
 

Main Panel 
 
To change the center location of the display, depress the mouse-wheel with the cursor 
positioned anywhere in the display area and move the mouse.  The display will follow.  
Alternately, a related item appears at the bottom of most context menus: 
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 Re-center at Mouse position – right-click where you want the new center to be 
and select this item. 

 
When Flightsim is running (connection with AFLT will be automatic), you may slew the 
user aircraft: 

 using either the Main Panel Slew controls or by moving the cursor over the 
aircraft symbol on the display, 

 depressing the left mouse button and dragging the aircraft symbol (and the user 
aircraft) to the desired position, or 

 with the Move User A/C to Cursor Position item in the context menu. 
 
Normally, Flightsim will be paused following any slew operation.  You may override this 
by checking the No Pause After Slew box.   
 
Undo and Redo buttons are below the slew controls.  (Ctrl-Z and Ctrl-Y may also be 
used.)  If you delete or add back a node near the edge of the display, the data may re-
center.  Most operations on the display can be undone/redone. 
 
Project Menu 

The Project menu is used to start new projects, load and save placement data, create 
the object libraries and select the airport reference file.  Several of these menu items 
have an associated listbox that displays the names of files recently selected for that 
purpose.  To reselect one of those files, simply click on its name.  To select a new file, 
click on the menu item and navigate to the file of interest.   
 
The Projects menu contains the following items: 

 Select Project – Select from a list of projects 

 Create New Project – Start a new project.  As noted earlier, you should not 
choose the copy of the airport .bgl in the scenery folder as your airport reference 
file since, if you do, you will be unable to “purge” it later.  Instead, make a copy 
outside any active scenery folder of the “scenery” .bgl and use the copy as your 
reference file.   

 Import Project Data from AFLT2/3 – Import data from a AFLT2/3 project 

 Delete Project – Deletes the currently-selected project 

 Save Placement Data – Saves current placement data to the Project Data 
Folder.  Two files are created: Placements.xml and LinkLight.xml.  A backup of 
each is saved in the Project Folder should you inadvertently save erroneous 
data.  Should it be necessary, both should be restored. 

 Save Placement Data as … - Saves the current placement data to another 
location 

 Clear Placement Data – Clears any existing data from the display 

 Compile Data - Opens the Make Library dialog. 

 Purge Reference Airport Stock Data – Initiates The Purge Airport Stock Data 
function (see PURGE AIRPORT STOCK DATA FUNCTION below)  

 (Re)Load Airport Image - Loads airport data from a .bgl or .xml file designated by 
the user and displays an image of the airport surfaces.  If you have airport files 
with varying “stock” lighting arrangements, you may select from among them at 
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any time.   If you have saved any placement data (Placements.xml  in the Project 
Folder), you will have the option of preserving it for use with the new reference 
airport.  But, do not retain any earlier placements if those placements are 
not directly applicable to the new reference airport file.  Also, when a new 
airport image is selected – even if it is identical to the earlier one -  the 
records of all deletions from the earlier stock data will be lost. 

 
View Menu 

The View Menu, as the name suggests, controls what is seen in the display area at any 
time. 
 
Airport designers often use closed or very narrow (0’ or 1’ wide) taxiways for special 
purposes.  AFLT classifies as a “narrow” any taxiway whose width is less that a user-
specified value (set from Set Taxiway Wide/Narrow Width).  While narrow taxiways may 
be displayed, they are otherwise largely ignored.  
 
Any combination of the following airport surfaces may be displayed: 

 runways 
 regular (“wide”) taxiways  > n  (i.e. wider than the  “wide/narrow” width) 
 “narrow” taxiways  < n  (i.e., “narrow” taxiways) 
 closed taxiways  (processed as regular taxiways when in view) 
 taxi- and parking-paths as well as an outline of parking stalls 
 aprons 

If you suppress the display of runways, the runway links are displayed instead. 
 
The View Menu also contains the following functions 

 Illumination – displays the illumination pattern of each standard 

 Stock Data – the “stock” lighting from the current airport reference file is 
displayed in place of the programmed lighting  

 Light Size Increase/Decrease/Auto – allows the user to control the size of the 
displayed lights 

 Set Taxiway Wide/Narrow Width - the dividing line between “wide” and “narrow” 
taxiways  

 Set Displayed Width of Paths/Narrow Links - unless set at 0, all paths and narrow 
taxiways are displayed using this width irrespective of their otherwise specified 
widths  

 Show Light Count – displays the current total number of lights in each category  

 Dark Background – displays the light symbols on a dark background for better 
contrast 

 On with PCL – displays only those lights subject to pilot control or that are 
otherwise turned on in low visibility. 

 

Options Menu 

The Options Menu contains the following items: 
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 Show Tooltips – When checked, a tooltip is displayed whenever the mouse 
cursor hovers over a light strip or element or the user aircraft symbol displaying 
positional and other information. 

 Display Formats/Units – opens a second dialog from which you select lat/lon 
display format and distance and elevation units.  

 Select Proximity (pixels) - the maximum distance between the mouse cursor “hot-
spot” and the center of a displayed node or the user aircraft symbol for selection 
of that node/symbol to occur. 

 Mouse Breakout (pixels) – the minimum distance the mouse cursor must be 
moved before a node or the user aircraft symbol will be “dragged” from its 
position. 

 Default Parameters – Opens a dialog (see next page) for specification of global 
runway and taxiway lighting and associated parameters, such as: color, spacing 
and offsets.  Dimensional items are specified in both feet and meters.  One set of 
default parameters is saved for the purpose of initializing new projects.  But, so 
that you may easily use different defaults in each project, a set of default 
parameters is held with each project. 

 
To open the dialog, click on either: 

o Default Parameters for This Airport, or 
o Default Parameters for New Airports, 

depending on which set you wish to edit. If you wish to apply a change to more 
than one project, you’ll have to edit each project individually. 
 
Please note, Spacing and Min Spacing are only effective on straightaways.  
Placing edge lights across from each other on straightaways requires a light on 
each side at each end of a straightaway.  So, on very short straightaways, the 
spacing of those lights may violate the Min. Spacing specification.  Resolution of 
such situations requires manually moving/deleting lights. 
 
Several parameters require explanation: 
o C/L Relative Size – Runway and taxiway centerline lights often appear 

distractingly large when drawn at the same size as the respective edge lights.  
This control allows you to reduce the size of centerline lights  to a proportion 
of the edge light size 

 
o C/L Bi-Directional (P3D Only) – Centerline lights are usually embedded in the 

runway or taxiway surface and, while nominally omni-directional in face are 
two lights, one aimed forward, the other back.  When this control is checked 
centerline lights specified as “Edge” type will be shown as two such light 
sources.  This feature is available only with P3D. 

 
o Turn >= - If the heading of two consecutive taxiway links differs by more than 

this amount, their intersection will be handled as a “turn”, i.e., an edge light is 
placed at the beginning and end of the turn and intervening lights spaced 
evenly based on the following parameter. 

o Corner Spacing <= - Within a “turn”, edge lights are evenly spaced based on 
a subtended angle less than the specified value. 
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While AFLT does not display a base model when a light is on the surface, it will 
place another model or display an image of your choice on the ground.  As 
discussed in Appendix “A”, AFLT includes three images of typical inset light units: 

 8”/22cm for omni-directional applications (filename “Surface_Omni”) 
 8”/22cm for centerline applications (filename “Surface_Bi_Small”) 
 12”/30cm for applications where a larger bi-directional unit is needed, 

e.g., surface-mounted approach lights (filename “Surface_Bi_Large”). 

These images may be replaced or supplemented by your own or (if you’ve got 
lots of processing power) by custom 3D models. 

 

 
 

Default Parameters Dialog 
 
The application of these images is specified near the bottom of the Default 
Parameters dialog.  Four categories of surface-mounts are available:  
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 Omni (for taxiway and runway edge light applications),  
 Centerline (typically the small bi-directional image, but the associated 

light will be omni-directional), 
 Split (e.g., runway end applications with displaced thresholds), and 
 Approach (typically, the larger bi-directional unit).  

 

 Don’t Purge PAPI/VASIs - Stock PAPI/VASI lighting may be superior to AFLT’s at 
close range.  However, until P3Dv4, PAPI/VASI visibility was far too short - a 
situation overcome by AFLT with inverse-mipmapped and LOD-variable lighting 
options.  Consequently, in some situations, it may be desirable to have both 
stock and AFLT lights.  Checking the Don’t Purge menu item accomplishes this 
(but you will have to adjust the position of the relevant AFLT PAPI/VASI to agree 
with the stock item. 

 Check for Updates at Start-up - AFLT can access its website server to determine 
if a new general release or development release is available.  When either is 
checked, AFLT will attempt to find an updated version at start-up.  If that 
operation is suppressed and you click on this item, AFLT searches for an update 
immediately.  You can also check for an update from the Help menu. 

 Reposition Aircraft when Data Loaded – When checked, if FlightSim is running 
when a project is loaded, the user aircraft will be repositioned to the geographic 
center of the data. 

8. CREATING/EDITING/DELETING LIGHTS 

Taxiways are divided into surfaces comprising the contiguous links (segments) not 
interrupted by a crossing taxiway or runway.  A single click on a taxiway link selects that 
segment only.  Use <Ctrl> and <Shift> to select multiple links in a surface.  Double-click 
to select all links in the surface.  Once a surface or taxiway link, light or line is selected, a 
right-click anywhere on the dialog brings-up a context menu listing the functions 
available for the selected element.  To add a single light or a line of lights, right-click with 
nothing selected.  The context menu will contain an appropriate subset of the following: 
 

Selected  Functions Cursor Posn 
Used 

Runways Add/Edit Edge and C/L Lights No 

 Add/Edit Approach Lighting No 

 Add/Edit PAPI/VASI Yes 

 Add/Edit Runway End Lights No 

 Delete (each of the above) No 

Taxiways Add Dual Light Bars Yes 

 Edit Link Lighting No 

Individual Light 1,2 Edit Light No 

 Move Light to User A/C Position No 

 Copy Light No 

 Paste Light Yes 

 Join Lights No 
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Selected  Functions Cursor Posn 
Used 

 Delete Selected Light(s) No 

Line of Lights 2 Edit Line Parameters Yes 

 Insert Light into Line Yes 

 Join Lights No 

 Delete Line No 

 Extend Line Yes 

None Add Single Light Yes 

 Add Line of Lights  Yes 

 Add Light Standard  Yes 

   
1  Certain of these functions are not available for taxiways that have been moved or 

otherwise edited. 
2  Certain of these functions are not available for runway end lights, approach towers 

or PAPI/VASIs.  Use the custom editors instead. 
 
The following function is always available from the context menu: 

 Re-center (display) at Mouse Position 

and, if Flightsim is running, also: 

 Move User A/C to Mouse Position; if a light is selected at the time, the heading of 
the aircraft will point to that light. 

 
Regarding deletions, for taxiway lights, you may either use a “delete” function or choose 
the Edit Link Lighting from the context menu and adjust the lighting as necessary.  When 
you delete lines of lights associated with a runway, e.g. an element of an approach 
array, AFLT will delete the same item from stock data.  If you delete a line of lights not 
associated with a runway, that lighting cannot automatically be deleted from stock data.  
To delete such lighting from stock data, select Stock Data from the View menu and 
delete the item again.  While you may delete individual lights from a line in placement 
data, there is no way for AFLT to accomplish the same deletion from stock data.  The 
alternative is to delete the entire line from stock data and re-create the line in AFLT 
 
Note that the centerline light at taxiway intersections will not be lit if more than two 
taxiways intersect.  This is to avoid the “spider web” of lights so common in Flightsim.  
Such intersections require manual placement of centerline lighting where desired. 
 
When pasting/inserting individual lights, if the cursor is hovering over a line of lights, the 
light is inserted into that line.  Otherwise, the light is placed at the location of the cursor.  
Select the light to be copied, right-click and select Copy Light from the context menu.  
Then, at each point where the light is to be pasted, right-click again and select Paste 
Light from the context menu.  Lights may be pasted into existing lines by right clicking on 
the line when the light is to be pasted.  If the light you are pasting is dissimilar to those 
already in the line, AFLT will ask for confirmation. 
 
Additional segments can be added to a line by selecting the light at the end where the 
segment is to be added, right-clicking and clicking on Extend Line in the context menu.   
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Joining lights allows multiple (previously) individual lights or lines of lights to be handled 
as a single entity.  To join lights, select either: 

 the individual light (that will become the first or last light in the line), or 
 the first or last light in an existing line of lights, 

right-click to bring up the context menu and select Join Lights.  This enables the “hot 
cursor”.  Then, hover the cursor over (capture) the individual light or the light at the end 
of the line to which the selected element is to be added, and then left-click.  If the light 
you are adding is dissimilar to those already in the line, AFLT will ask for confirmation. 

 
Initiating Other Functions - Upon selecting a context menu function, a new dialog will 
appear to support the creation or replacement of the selected element.  If the selected 
element (e.g., edge lights) already exists for the selected surface, the dialog will be 
initialized to reflect that element.  Otherwise, the dialogs are all initialized with 
representative default parameters. 
 
Once the new specification is complete, click the dialog’s Place Lights button.  The 
dialog will close and the results will appear on the airport surface displayed as a series 
of connected symbols. 
 
Selecting Delete simply deletes the lights of that type following confirmation. 
 
Some of the element creation/editing dialogs may require positioning information.  The 
position of the mouse when right-clicked to bring up the context menu is retained and 
made available to the selected dialog.  Most dialogs that use cursor-positioning 
information will also accept user aircraft position if Flightsim is running. 
 
All the lights in a line are initially placed: 

 at, or in the case of tower-mounted lights a fixed distance above, ground level or 
the specified elevation, 

 using a single, specified light style, and 

 unless surface placement is designated, with a 3D model. 

If you wish to vary these characteristics for an individual light in a strip, following initial 
placement, select and edit that light as desired.  
 
Moving Lights – Lights may only be moved by “dragging”.  An entire line of lights may be 
selected and “dragged”. Within a line, individual lights may be moved as follows: 

 in a line created as a line of lights, the end lights and those at “corners” may be – 
“dragged” in any direction; upon completion of the “drag” operation, intermediate 
lights (between ends and/or “corners”) are automatically moved to form a series 
of straight lines; only ends and corners may be selected; 

 in other lines (e.g., edge lights or approach light elements), individual lights may 
only be moved in the direction of the line. 

 
Illustrated below are the various light specification dialogs.  For the most part, these 
dialogs are self-explanatory.  
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Place Runway Edge and Centerline Lights 
 

 
 

Place Runway Lights 
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Place Runway Approach Lights  

AFLT supports all the modern approach lighting systems included in Flightsim.  
However, in the case of AFLT, you can tweak these systems to your heart’s content.  
AFLT also supports a variety of classic Canadian and US systems.  To access these 
systems, you must first click the Classic Systems checkbox. 
 
The dialog for modern FAA systems is shown immediately below. 
 

 
 

Place Approach Lights (FAA) 
 
Most items should be self-explanatory to those familiar with the configuration specified.  
However, two in the upper right-hand quadrant bear explanation:  

 3D Models on Runway checkbox under Threshold Lighting - AFLT automatically 
suppresses the 3D model for any runway, taxiway or approach light on a runway 
surface and displays element as a surface light instead.  However, threshold light 
bars in approach lighting systems are often located just on the runway surface 
(where the 3D model would normally be suppressed).  Checking this box – which 
is only enabled when needed – ensures all lights in the bar have 3D models. 

 Array Elev and associated AGL checkbox – The FAA recommends that all lights 
in an approach array be in a horizontal plane.  By default, AFLT places all 
approach lighting elements on the ground (i.e. 0 AGL).  If the terrain is relatively 
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flat (or has been flattened), AFLT is generally compliant.  If the approach is over 
water (in which case any elements in the water are at sea-level) or over 
undulating terrain, this control forces all lights to the same elevation.  If the 
elevation is set to “0” when AGL is checked, the elevation checkbox will be set to 
ARP elevation.  Otherwise, it’s up to you to specify the desired elevation. 

 
While you may select either end of the runway in the Approach Lights dialog, and 
also in those for Runway End lights and PAPI/VASIs, only one end may be added 
or edited at a time.  When you click on Place Lights, only the lights for selected 
end of the runway will be updated.   
 

 
 

Place Approach Lights (Calvert) 
 

If you select a Calvert-based system, the dialog takes on a somewhat different 
appearance as shown below.  Again, the titles of the fields should clearly indicate t5heir 
purpose 
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Finally, the classic systems.  Most, but not all of, the classic systems use the dialog 
below.  While the list of pre-formatted systems concentrates on Canada and the USA, 
between the three dialogs, each of which includes a “custom” mode, you should be able 
to specify just about any approach lighting system that exists. 
 

 
 

Place Approach Lights (Classic) 
 
Shown below are the basic patterns of several of the classic approach systems.  The 
one labeled Left Edge in the illustration is called Left Edge Advanced (USA) in the 
Configuration dropdown box.   Left Edge in the Configuration list is a simple line of one 
or more lights extending from the left edge of the runway.  LIAL is an early Canadian 
system and is still in use at smaller airports.  National Standard (USA) is an early version 
of MALSF.  The “N” in “N and One” stands for the number of lights along the left edge of 
the array.  Three and One in the illustration below is an example of “N and One” with 3 
lights per tower along the left edge. 
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Place PAPIs and VASIs  

The dialog for specifying PAPI/VASI position and characteristics is shown below.  While 
covered by the Type combobox “dropdown”, there are an identical set of controls for the 
right hand side as for the left.  The purpose of most controls is obvious.  But  Two 
require explanation: 

 Copy Left button – Usually, the left and right side units are identical.  As the 
name suggests, this button allows you to copy all the specifications for the left 
side into the right side controls. 

 (Re)Position at Cursor and A/C buttons - Clicking either the Cursor or A/C 
buttons overrides the position specification in the bottom portion of the dialog and 
places the specified PAPI/VASI arrangement at the position of the cursor when 
previously double-clicked or at the current position of the user aircraft 
respectively. 
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Selection of PAPI/VASI 
 

Some of the available light source options don’t provide sufficient intensity in daytime for 
PAPI/VASI operation beyond about 1 mile.  However, by checking the Don’t Purge 
PAPI/VASIs item in the Options menu, you can have both stock and AFLT glideslope.  
Specify the position and glideslope parameters for the AFLT lights exactly as indicated in 
ADE or other airport editor.  Because AFLT and Flightsim use different reference points 
and computational precision, the lights would not normally coincide.  But, should you opt 
for this approach, AFLT automatically applies corrections to ensure that the position and 
timing of the switch in above/below indications of its lights and those of the stock data 
are very close together – likely indistinguishable beyond a few hundred meters.  If you 
need perfection, you’ll have to experiment with the parameters for PAPI/VASI 
configurations.  Don’t be afraid to experiment.  The worst that can happen is that you 
can’t get fully-simultaneous operation. 
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Place Runway End Lights 
 

 
 

Place Runway End Lights 
 

The Single and Dual radiobuttons specify either a single row of lights across the end of 
the runway, or two short rows, one on either side.  Runway end lights always display a 
3D model, even if they are on the runways surface – except of course at displaced 
thresholds.  If the selected end of the runway has a displaced threshold, then similar 
entry fields for a second set of parameters appears below the first, together with a 
checkbox that allows you to select whether or not additional lights are to be generated. 
 
Place Taxiway Edge and Centerline Lights 

Taxiway lighting position and other characteristics are specified using the Default 
Parameters dialog available under the Options menu.  The dialog below allows you to 
adjust the edge and centerline lighting of the taxiway links.  Select one or more links in 
the same taxiway and right slick.  Choose the Edit Link Lighting item from the context 
menu.  The dialog is initialized as a compendium of the current lighting arrangement of 
the selected link(s). 
 
Application or removal of edge lighting is simple.  Just check/uncheck the applicable 
check.  For centerline lighting you may choose between all green or alternating 
green/amber.  If the latter you may use either omni-directional lights or bi-directional.  To 
remove centerline lighting, uncheck the selected radio-button. 
 
AFLT allows you to offset centerline lighting.  But, while all li9nks in a taxiway segment 
are oriented in the same direction, abutting taxiways may be oriented differently.  Should 
that be the case and you have specified a taxiway centerline offset (using the Default 
Parameters dialog), the offset in those taxiway will be opposite.  You can correct this by 
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selecting all the links in one of the taxiway segments and checking the Reverse C/L 
Offset checkbox.  (This control is only enabled if you have specified a centerline lighting 
offset. 
 

 
 

Place Taxiway Lights 
 

Similarly, if you specify uni-directional alternating green/amber centerline lights, those 
lights may be oriented incorrectly.. You can correct such situations by selecting links with 
lighting in the wrong direction using the Reverse Uni-directional Lights checkbox. 
 
Finally, to revert the selected links back to stock data, click the Revert to Stock button. 
 
In all cases, when you have made your selections, click Place Lights. 
 
Place Taxiway Dual Light Bars 
 

 
 

Place Dual Light Bars on a Taxiway 
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Light bars may be placed on either side of a taxiway by selecting the taxiway, positioning 
the cursor on the taxiway at the location where the light bars are to be placed (to the 
side) right-clicking and selecting Add Dual Light Bars from the context menu. 
 
Add/Edit Individual Light or Line of Lights 

You are first greeted by: 
 

 
 

Place Individual or Line of Lights 
 

Once you specify the name of the model you wish to place, a dialog similar to one of the 
two below will appear.  If Flightsim is running, the Start at A/C radio button will be 
enabled and, if checked, the line will start at or the light will be placed at the position of 
the user aircraft.   The actual format of the new dialog will vary, depending on the type of 
light being placed, i.e., additional fields may appear and others shown may be missing.   

 

 
 

Place a Single Light 
 

You may enter either No. of Lights or Nominal Spacing.  When all selections have been 
made, click Place Lights.  The dialog will close and AFLT will enter the “hot cursor” 
mode, (i.e. each left click will place a line node).     
 
If No. of Lights has been entered, that number of lights will be placed in a line after the 
first left-click and AFLT will exit the “hot cursor” mode. Otherwise, following each left-
click, the required number of lights will be evenly placed between the current and 
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previous cursor positions based on the Nominal Spacing entry.  Either double-click when 
placing the final node in the line or right-click after placing the final node to exit the “hot-
cursor” mode. 
 

 
 

Place Line of Lights 
 

When a light (or line of lights) is specified to be on the surface, the corresponding 
surface mount image can be suppressed with the No Surface Model checkbox.  This is 
to avoid a situation where surface mounts are the default and two or more images are 
placed on top of one another with flickering resulting. 
 
Please note that, when placing aero-navigational beacons, the Elevation field refers to 
the height of the tower whereas, for other light types, it generally refers to the elevation 
of the model base. 
 
Add/Edit Ground-Illuminating Light Standards 

AFLT includes a variety of 3D models suitable for ramp, parking, sidewalk and street 
illumination. And, you may add your own as described below.   
 
Traditional ramp lighting programs create a .bgl file that includes one or more slightly 
elevated, horizontal illumination planes for each light standard – a generic term used for 
the 3D model associated with ramp lighting, street light, etc.. Unfortunately, these planes 
cause flickering if the plane(s) for one standard overlaps the plane(s) of another. AFLT 
on the other hand effects ground illumination through the use of a single ground-poly.bgl 
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no matter how many standards are programmed. Thus illumination plane overlap – 
which adds a great deal of realism, especially at larger airports, is possible.    
 
The available light standards are light standards are specified in the file 
AFLT\standards.txt  (Appendix “F”).  The corresponding .mdl files are saved in the 
“Standards” subfolder of AFLT\BaseModels\relevant Fightsim version. 
 
When you create a new light standard, you are first asked to specify the name of the 3D-
model for the standard using a simple combo box. Once selected, a dialog in the form 
below opens.  When editing an existing standard, the dialog opens immediately. 
 

 
 

Add/Edit Ground-Illuminating Light Standard 
 
Some of the fields on this dialog require explanation: 

 GP Layer is the layer at which the illumination-planes are displayed. This is the same 
layering scheme as is used in ADE-GP. The value entered in this field must be 
higher than that of any airport GP over which it lies. Otherwise, the airport GPs will 
be displayed on top of the illumination.  (This maay be what you want for special 
effects.)  Further, to ensure all your ground illumination is displayed without 
flickering, you may have to assign different layer numbers to adjacent standards.  
(Illumination GPs are rectangular.  If the illumination of one standard lies in the dark 
area of another with the same layer number and the latter is drawn last, the brighter 
areas of the first may be overwritten.)  You’ll need to experiment when the 
illumination of one standard overlaps that of another with the same layer number. 

 Overall Height/(concrete) Base Height – the height of the displayed model and its 
concrete base respectively. 

 Color – The color of the ground illumination.  Two stock colors (White and Fog) are 
provided.  Provision is made for two additional colors to be added by the user. 

 Heading – the value entered should be: 
 for ramp lights, the direction in which the light is to be cast, 
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 for parking standards and street lights, such that the light is cast to the left, or to 
both sides for dual-headed standards 

 for sidewalk lamps, it the light is cast straight down, it doesn’t matter.  If the 
illumination is to be directional, such that the light is cast to the left  

 Heads – Many of the provided models have multiple illumination heads. AFLT allows 
(but does not require) you to specify a light beam for each head to better simulate 
the actual lighting at your airport. 

 X / Y / Z – the physical position of each head relative to the top of the standard 
 On/Off – to enable/disable a beam 
 Relative Heading – the nominal heading of the beam relative to the standard 

orientation 
 Declination – the vertical angle of the beam below  horizontal 
 Beam Width – the nominal; width of the beam 
 Beam Height – the vertical angle covered by the beam 

 
With a little imagination, you should be able to accurately simulate the illumination 
coverage at any airport.  
 
Standards are usually displayed on the AFLT surface as a simple dot with a small arc 
indicating the heading of the standard. To see the shape/size of the illumination pattern, 
select Illumination under the View Menu 
 
Important: While the illumination GPs and associated textures may be saved to 
any location, the associated .bgl containing the 3D models is subject to any 
excludes for your airport if saved outside the primary airport folder at a lower 
scenery-library priority than the base airport folder.  This is not an issue for 
P3Dv3+, since the illumination standards are saved to the DocumentPrepar3D 
v…\Add-ons folder.  But, for FS9 and FSX, when using ground-illuminating 
standards, the scenery folder specified on the Make Library panel should be your 
primary airport folder. 
 
9. CREATING A LIBRARY OF ELEMENTS 

Clicking Compile Data (Project menu) brings up the Make Object Library dialog. 
 

The top line of the dialog will reflect which versions of Flightsim are installed on the 
system.  Select the version to which the library about to be made is to apply. 
 
For FS9 and FSX, the object libraries and required textures will be copied to the Scenery 
Folder if that folder is specified in the Scenery Folder Path textbox. If the Scenery Folder 
is a sub-folder of FlightSim’s Addon Scenery folder, you need only specify the path 
relative to Addon Scenery.  (The full path name for each Flightsim version will be 
automatically derived.)  Otherwise, you must specify a fully-qualified path for the 
selected Flightsim version.  If the specified path ends with “\scenery”, AFLT assumes a 
companion \texture subfolder.  If the path does not end with “\scenery”, AFLT assumes a 
folder containing both the \scenery and \texture subfolders.  If either anticipated 
subfolder does not exist, AFLT will create it/them on the first save.  Once a Scenery 
Folder is specified, the same folder will be used for all Flightsim versions unless 
changed. 
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For P3D, a “P3D add-on package” containing all the required files is generated, a folder 
named ”AFLT for P3D” is created in the appropriate Documents\Prepar3D vn Add-ons 
folder and the add-on package copied into that folder. 
 
AFLT supports pilot-controlled lighting (PCL), i.e. the ability for pilots to turn on airport 
lights outside normal hours for the airport.  In real-life, usually this is done by keying the 
COMM transmitter a certain number of times.  Unfortunately, there is no way for 
Flightsim to report depression of the “mic-key”.  So, AFLT offers several (albeit 
unrealistic) alternatives.  Instead, you may use a certain transponder code or tune one of 
the COMM, NAV or ADF systems to a frequency of your choice (within its range).  You 
may also control how long the lights stay on after you trigger PCL.  If you don’t set an 
auto-off value, the lights will go off immediately upon you deselecting the specified 
transponder code or frequency. 
 
If pilot-controlled lighting (PCL) is required at your airport, select a pilot-controlled 
lighting control from the Control/Variable combo box (radio/navigational systems.  Then, 
specify the "lights-on” value for the control/variable in the Freq/Code textbox.  Enter the 
value exactly as the value will appear on the control (e.g., 1234 for the transponder or 
123.70 otherwise).  If COMM is selected, please note PCL is only triggered if the COMM 
unit then-currently selected for transmit is tuned to the specified frequency.  Note that 
runway and taxiway lights are automatically selected as being operational under PCL.  
Other types of lights must have been manually designed as being operational under PCL 
when they are created/edited in AFLT. 
 
 

 
 

Make Library Dialog 
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If you want to be able to deselect the PCL lights-on criteria once PCL has been invoked 
but have the lights remain on, enter the number of minutes after which the lights will 
automatically be turned off in the Auto-off (min.) text box.   
 
For airports having 24 hr operation, check the 24 hrs. checkbox.  Otherwise, enter the 
operating hours (i.e., the hours outside of which the lights will normally be off) in local 
time and the airport's UTC offset in hours (decimal hours if necessary).  
 
Some large international airports operate with their runway and approach lights (at least 
for the active runway) on all the time.  The Runway and Approach Lights Always On 
checkbox allows you to select this capability for your airport. 
 
Please be aware, pilot-controlled lighting, specified airport operating hours, and Runway 
and Approach Lights Always On necessitates additional processing for each light.  
Hence, they may have a detrimental impact on FPS.  So, these features should be used 
only where required.  However, only the most “challenged” systems should be 
significantly affected. 
 
The same light source is used for all lights in an object library.  As noted earlier, 
depending on the version of Fligfhtsim selected you have a choice of up to 3 of the 
following sources: BGL_LIGHTs (FS9 and FSX), standard effects, inversely-mipmapped 
effects, and for P3D, LOD-variable-sized 3-plane lights.   
 
AFLT generates all required effect (.fx) files on-the-fly.  During development, it was 
found that a one-size-fits-all approach with standard effects was not practical.  So, AFLT 
provides the ability to easily customize effects (see Appendix “D”).  However, AFLT 
ships with effect configurations that should serve as a starting point for your further 
customizations.  
 
Shadows are expensive in terms of FPS.  (Shadows are essentially 2D models.)  
Shadows are automatically suppressed for lights mounted on towers.  (3D tower models 
are usually of a long, fixed length to allow for variable height of tower-mounted lights).  
Consequently, the bottom of a tower generally will be well below ground level.  However, 
Flightsim always displays a shadow for the full length of the tower, thus generating 
shadows for the below-ground portion as well.)  To suppress all shadows, check the Kill 
Shadows checkbox. 
 
If you have a FPS-challenged system but still wish to realize some of the benefits of 
AFLT, try suppressing the display of the 3D models by clicking the Light Only checkbox.  
While the display in Flightsim will not likely be much different than stock lighting, AFLT 
still allows you a lot of customization not otherwise available.  You can also use this 
feature to check the FPS-impact of the 3D lights. 
 
Finally, click the Create/Save Library button.  If no Scenery Folder has been specified, a 
warning will be issued.  Whether or not a Scenery Folder is specified, the object libraries 
and .mdl files are also saved in /Files subfolder of the Project Folder.  As well, if effects 
(either type) are used, all required effects are normally generated on-the-fly and copied 
to the \Effects subfolder in the case of FS9 or FSX, or to the add-on package if P3D.  
 
When compiling for FS9 or FSX, you’ll see the window flashing on and off rapidly.  
That’s the compiler, which I have been unable to find a way to hide 
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Run the relevant FlightSim version to see the results. 
 
Ensure you have only one version of an airport in your Flightsim scenery folder. 
Especially during development or testing of a lighting scheme, you may have created 
two or more projects for the same airport.  AFLT assigns different guids each time a 
project is compiled.  If more than one library covering the same lighting elements exist in 
a scenery folder, this effective specifies two or more guids for each element – in which 
case Flightsim will not display that element.  So, if some or all of your 3D models are 
missing in your Flightsim display, first check your scenery folder for duplicate libraries. 
 
Also, if you have previously used AFLT2 or AFLT3 to generate lights for P3D you 
wish to keep along with your AFLT4 lights, you must: 

 rename the AFLT2 or 3-created folder …\Documents\Prepar3D vn Add-
ons\AFLT for P3D, and 

 edit the second line of the file “add-on.xml” in that folder to agree 

prior to compiling for P3D with AFLT4 (which will create another folder named 
“AFLT for P3D”.  Otherwise, AFLT4 will add it’s own files to the AFLT2 or 3 folder 
and the mixture won’t work. 

10. PURGE AIRPORT STOCK DATA FUNCTION 

If you simply add AFLT library .bgls to an airport’s scenery folder, you will see not only 
the AFLT lights/models but also the stock lighting.  The Purge Airport Stock Data 
function creates an airport .bgl or .xml file (whichever you defined as the airport 
reference file) “purged” of all the stock lighting which has been used/replaced by AFLT.  
Note you may designate in the Options menu that PAPI/VASIs not be purged.  You 
would then use the “purged” file to replace the earlier airport .bgl or .xml file.   
 
If you created the project with a .bgl file, that file will have been compiled for a particular 
version of Flightsim.  Its use, therefore, will be limited to other compatible Flightsim 
versions.  Consequently, AFLT’s Purge Airport Stock Data function asks for a Flightsim 
version specification before purging the lighting specifications.   
 
If you started with a .xml file, its use too is restricted because it may contain data not 
compatible across all Flightsim versions.  If you are creating lights for use with several 
Flightsim versions, you may have to load the airports .xml for one or more of the 
versions currently loaded in order to create “purged” .xml files for each version.   
 
If you attempt to create a purged file for FS9 but the airport reference file is for a version 
later than FS9, AFLT will detect the situation and ask you to designate a FS9 version of 
the file.  Unfortunately, AFLT cannot do the same with an .xml airport reference file.  So, 
using a .xml reference file and the purged file either won’t load or doesn’t have the 
desired effect, you should suspect a version mismatch. 
 
In either case, the purged file name is suffixed with the entered version.  
 
Purged files are always saved to the Project Folder.  You would normally replace the 
airport .bgl file in your scenery folder with the purged .bgl.  If a .xml file, you would 
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normally load it back into your airport editor to create a new version of your airport .bgl 
without the stock lights you replaced.  
 
At the time a bgl file is purged, if the specified version of FlightSim is installed, you are 
given the opportunity to have that file saved to your scenery folder.  (The original airport 
.bgl file name will be suffixed with “.xxx” to disable its processing).  If you choose not to 
have AFLT so save the file for you, you will have to apply it appropriately, manually, 
later. 
 
AFLT will not let you replace the airport reference file with a purged version, since doing 
so would defeat AFLTs ability to (re)generate custom lights.  If you have chosen the .bgl 
in your scenery folder as the airport reference file, make a copy of that file and select the 
copy as your reference file.  Similarly, if you’ve chosen an .xml file as the reference file, 
make a copy of it and “purge” the copy. 

11. SPECIAL CIRCUMSTANCES 

Lights in Close Proximity - It appears that FS9 has difficulty initializing the rendering of 
certain lighted models in very close proximity when approaching from a distance, 
resulting in a “crash”.  Given the complete absence of diagnostic information at the time 
of the “crash”, the precise cause of the problem is not known.  FSX does not appear to 
be similarly affected. 
 
In the case where the problem was discovered, when the light source was BGL_LIGHTs, 
two strobes 2.5’/0.7m apart triggered the crash, but two others 5’/1.5m apart were OK, 
suggesting a minimum separation of 3.5’/1m.  When effects were substituted for the 
BGL_LIGHTs, the latter two strobes also resulted in a crash, indicating FS9 is less 
tolerant of effects.  On the other hand, steady lights as close at 1’/0.3m were rendered 
without difficulty, suggesting that blinking lights, e.g., strobes and, aeronav beacons. are 
most susceptible. 
 
So, should you experience a unexplainable FS9 crash when approaching an airport with 
AFLT custom lighting, review the spacing of the lights - especially that of strobes and 
aeronav beacons. 
 
Large Number of Effects - From our testing on large airports, it appears there is an 
internal (to Flightsim) limit to the number of effects that can be displayed. The version of 
KLAX we were testing had nearly 7000 lights.  (Each light requires an effect)   Flightsim 
“struggled” when effects were used as the light source at KLAX. Exactly where the 
limit is has not been determined - and it may be dependent on processing power and/of 
FPS.  If your airport has lights numbered in the thousands, you may experience similar 
difficulty.  Should that occur, try a light source that doesn’t involve effects. 

12. TWEAKING AND FINE_TUNING 

AFLT ships with a set of default values for all functions.  These are commonly used 
values for the respective airport lighting features.  However, these defaults may not be 
the most appropriate value for a given airport.  Consequently, virtually all aspects of 
AFLT are “fine tunable”.  That includes airport surface parameters, e.g. runway edge 
light offset, light characteristics. 
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Familiarity with Appendices “B” through “D” will be an asset in understanding the 
balance of this section. 
 
AFLT supports four types of lights: 

 BGL_LIGHTs (FS9 and FSX only) 
 Standard effects 
 Inverse-mipmapped effects 
 LOD-Variable lights (P3D only) 

 
AFLT’s default light size is about 1m/3ft in diameter – generating a light-ball 
approximately the size of a BGL_LIGHT.  Appendix “C” specifies the size of each type of 
light relative to this default size.  As you can see from Appendix “C”, the default size for 
strobes and PAPI/VASIs is somewhat larger.  For all but BGL_LIGHTs, you may change 
these relative size values as necessary. This size can be further adjusted: 

 based on the Light Size Adjustment specified in appendix “C” for the color of the 
light, and 

 to reflect light intensity (effects for higher intensity lights being large than those 
for lower-intensity light). 

 
BGL_LIGHTs are very processing-efficient - more so than effects.  BGL_LIGHTs 
together with simple 3D models have a minimal affect on FPS.  However, the size of 
BGL_LIGHTs is fixed.  Their brightness is a function of the specified intensity for the 
light.  BGL_LIGHTs are rendered in FS9 only.  In FSX, a light element specified to use 
BGL_LIGHTs is rendered as an automatically-created effect the same color as specified 
for the BGL_LIGHT.  BGL_LIGHTs cannot be used in P3D.  
 
AFLT’s “standard” effects are based on the file BaseEffects.fx in the AFLT\Effects folder.  
Essentially, this is a “dummy” effects file certain of whose parameters are adjusted at 
compile time using specifications in the applicable BaseEffects_version.fx file in the 
same folder.  This allows for customization on a per Flightsim version basis.  .  Please 
refer to Appendix “D” for further detail on customization of effects. 
 
AFLT’s inverse-mipmapped effects use a special texture with inversely-sized mipmaps, 
i.e., the relative size of the image in the mipmaps increases as the distance from the 
light increases, increasing the visible range of small effects.  Inversely-mipmapped 
effects are based on the file “BaseEffect_Mipped_FS9.fx.  Unfortunately, FSX’s and 
P3D’s handling of effects preclude use of inversely-mipmapped effects 
 
The other alternative for light source is variable-sized 3-plane models.  These are not 
lights per se; rather, they are brightly-colored models comprising 3 circular planes in the 
X, Y and Z axes.  They are designed so that their size varies inversely proportionally to 
Flightsim’s internal level of detail (LOD) of the model at any time, i.e., the lights are 
rendered at minimum size at LOD_100 and at maximum size at LOD_1.  Light size 
increases or decreases in small increments as the user aircraft moves towards or away 
from the light.  This concept was pioneered by Christian Bahr.   These lights can be 
made visible up to 18 nautical miles (the distance at which Flightsim begins to discard 
scenery models) by adjusting the Range entry in Lights.txt (see Appendix “C”).  The 
minimum size of each light is controlled by the Light Size (Medium Int.) – Bahr entry in 
Lights.txt. 
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AFLT’s settings in Colors.txt and Lights.txt give a reasonably uniform appearance of 
lights across all light sources and Flightsim versions.  However, these settings may not 
be ideal in your application.  If the color of a light is not to your liking (in particular the 
blue taxiway lights), experiment with the RGB and Light Intensity Adjust values in 
Colors.txt. 
 
The size of effects and LOD-variable lights in Lights.txt controls the approximate size of 
the bright section of the light bloom at very close range.  It is a trade-off between close-
up appearance and the way the lights fade as the user aircraft moves away.  Some 
experimentation will be required to achieve the most suitable size.  So, when judging the 
close-up size, view the light from a representative distance, recognizing that the user 
aircraft will seldom be VERY close to a light.  
 
As shipped, AFLT displays all colors at their maximum intensity.  This may result in 
certain lights appearing too bright.  The brightness of each color may be reduced by 
adjusting the Color Intensity Adjust setting for the color in Colors.txt.  Depending on the 
color and the magnitude of the change, this adjustment might also be useful in reducing 
the apparent close-up size of lights. 
 
AFLT saves the placement data for each project in a XML files named, imaginatively, 
“Placements.XML”.  Depending on your skill level, you may find it more convenient to 
make certain adjustments to your data by directly manipulating this file.  If you do so, be 
sure to make a back-up copy before editing.  And be aware, the file can become 
unreadable due to something so insignificant as a missing or extra quote mark.  So, be 
forewarned.  I will not be able to help you recover your data.  Appendix “E” described the 
data formats (to the extent useful for manual editing). 

13. SUBSTITUTION/ADDITION OF BASE MODELS 

You may replace the provided base models and add new ones.  But, before doing so, 
you should examine the stock textures obj_AF_Lights, obj_AF_Lights_Dayglo and 
obj_AF_Lights_LM (found in the Base Models\Textures folder) to appreciate how they 
are used and their inter-relationship.   
 
Other than for wigwags, the only firm requirement is that a custom base model contain a 
single, empty attachpoint.  Both the attachpoint and the model can be named as you 
wish.  The location of the attachpoint is not important.  But it will be necessary to specify 
in BaseModels.txt offsetting information for the light sources. 
 
You may use any texture for the model and lens – or different textures for each.  But, if 
you wish the light lens to be colored to match the light, you must either use the stock 
texture obj_AF_Lights or implement a similar scheme on your own texture.  
 
For FS9 models, if you use the stock texture obj_AF_Lights.bmp for the light lenses, 
AFLT will automatically apply obj_AF_Light_Dayglo.bmp whenever the lights are on. If 
you use your own texture, AFLT will look for a file (.bmp or .dds) named 
“texture_Dayglo” and use it when the lights are on.  If it doesn’t find a “dayglo” texture it 
will complain, but the model will still be useable (however, of course, the lens will not 
“illuminate” in the daytime). Unfortunately, “dayglo” textures cannot be used with FSX 
models.  If you provide it, a “_LM” texture will be applied as usual. 
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For custom wigwag models, in addition to the attachpoint, the two light lens must be: 
 a separate element of the model, 
 displaced negatively in the Y-dimension sufficiently far from other portions of the 

model to avoid flickering,  
 displayed unconditionally (no LOD assignment), and 
 textured with a file whose name ends with “_WigwagLens”. 

For FS9 models only, AFLT will alternately apply the noted texture and one whose name 
ends with “WigwagLens_On” – which should be more brightly colored than 
texture_WigwagLens but otherwise identical.  Please refer to the stock “WigWagLens” 
textures. 

 
Place each version (FS9/FSX) of your model in the applicable Base Models folder and, if 
you use non-stock textures, place a copy of your new texture (32 bit, DXT and/or DDS 
formats as necessary) in the Base Models\Textures folders. 
 
If you are simply replacing a stock base model (using the same name) and your 
attachpoint is in the same location as in the stock model, you need do nothing further.  
However, if you have moved the attachpoint, have renamed the file or are adding a new 
base model, you will have to make a new, or update an existing, entry in BaseModels.txt  
(see Appendix "A") and perhaps also Lights.txt (see Appendix “B”).   

14. DISTRIBUTING YOUR AIRPORT  

You are permitted to distribute AFLT-generated custom lighting with your airport so long 
as your airport is made freely available and its distribution and use does not involve an 
end-user paying a fee of any kind.   
 
With simobjects-based lighting, you need only include a copy of the AFLT for P3D folder 
in your …\Documents\Prepar3d vn Add-ons.   If you have created custom lights for more 
than one airport but don’t intend to distribute them all, you may wish to delete from the 
included SimObjects and XML folders the sub-folders for the airports not to be 
distributed.  (Leaving them will do not harm other than possibly prompting your users to 
ask about them.)  Your user need only copy this folder into his/her own should 
“user\Documents\Prepar3d vn\Add-ons” folder.  P3D will detect it automatically. 
 
For FS9 and FSX, you’ll need to provide your users with: 

 the purged airport .bgl(s), 

 the relevant AFLT_xxxx_Bases _v.bgl and AFLT_xxxx_Lights_v.bgl files, and 

 all the effect files with names beginning “fx_AFLT4_” in  your Flightsim Effects 
folder, collected in a folder named “Effects” (AFLT’s effects are identical for each 
FlightSim version). 

Your users must copy these effects into their own Flightsim Effects folder.  The other 
files should be placed in an active scenery folder.   
 
Of course, you should also include detailed instructions to your users for installing these 
files and for disabling their original airport .bgl file(s). 

15. SUPPORT 
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Airfield Lights Toolbox's support forum is located in the Scenery Design - Airport Design 
support area at http://www.fsdeveloper.com.  Please direct your problem reports, 
suggestions for improvement and other comments there. When you report problems, 
please include relevant details.  In particular, the AFLT version number, the exact error 
message and a summary of what you were doing at the time are likely to be particularly 
helpful.  If you are asking for support with a particular lighting issue, please attach the 
complete Project sub-folder.  Without it, it's unlikely I can be of much help.   
 
I also have a support website at http://stuff4fs.com for all my airports and development 
utilities.  (Navigate to the User Applications / AFLT page.)  Among other things, the site 
lists all known problems with the latest release. The most recent release of Airfield Lights 
Toolbox is available from that site as are occasional development releases of new 
features. 
  
While I can’t promise to resolve every issue you report or include every feature addition 
you propose, I will undertake to support and enhance Airfield Lights Toolbox in a manner 
consistent with it becoming and remaining the tool of choice airfield lighting for Microsoft 
Flight Simulator and Lockheed Martin’s Prepar 3D. 
 
Enjoy, 
Don Grovestine 
don@stuff4fs.com 

END USER LICENSE AGREEMENT 

As used in this end user license agreement, the terms "Airfield Lights Toolbox" and 
"AFLT" shall be construed as encompassing the full contents of the downloadable 
archive (.zip) file created and/or posted for distribution on “download sites” by the author, 
including without limitation: the executables file AFLT.exe, AFLT(exe).exe and AFLT 
(Install).exe, the associated user manual, the files BaseModels.txt, Colors.txt, Lights.txt 
and any files proprietary to third parties including but not limited to the files BGLC_9.exe, 
bglcomp.exe, bglcomp.xsd and Ionic.Zip.Reduced.dll. 
 
You are granted a free, non-exclusive right solely to install and use Airfield Lights 
Toolbox on your computer system(s) for your own personal enjoyment and, subject to 
what follows and the rights of others, to use and distribute work products created or 
modified with Airfield Lights Toolbox (“derivative files”) as described in the section of this 
manual entitled DISTRIBUTING YOUR AIRPORT WITH SIMOBJECTS. 
 
You may not: 

 upload Airfield Lights Toolbox in whole or in part to any file distribution system,  

 reverse engineer, disassemble or decompile any part of Airfield Lights Toolbox, 

 incorporate Airfield Lights Toolbox in whole or in part into any commercial 
product or facility, “shareware” or “freeware”, or 

 use Airfield Lights Toolbox or any derivative files in the development, marketing 
or support of, or incorporate derivative files in, any commercial product 

without the express written permission of the author.  Use as may be permitted for 
commercial purposes may be subject to a license fee.  
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Your use of Airfield Lights Toolbox is entirely at your own risk.  You assume and are 
responsible for any and all liabilities and damages arising therefrom no matter how 
caused. 
 
By installing or otherwise using any part of Airfield Lights Toolbox, you are deemed to 
have agreed to the foregoing. 
 

Airfield Lights Toolbox - Copyright © D. Grovestine 2013 - 2021 
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Appendix "A" - Base Models Supplied 
 
Base models for all but surface mount applications must fall into one of the following 
categories: 

 Approach - uni-directional light intended as a threshold light in approach lighting 
configurations either as a threshold light or mounted on a tower. 

 Approach_T – a simple horizontal mounting bar 1m. long, which will be adjusted on-
the-fly as needed and to which will be attached one or more posts and one or more 
light heads.  Two associated base models are required: 

o Approach_Post –  post to be attached to Approach_T 

o Approach_Head –uni-directional light to be attached to Approach_T 

 Beacon - a 50 m. high tower.  You may choose to have a blinking light atop it or a 
blinking light at night and a strobe during the day 

 Edge – a basic light mount intended primarily for taxiway and runway edge lighting 
applications 

 Obstruction – dual obstruction light assembly on a 5' post 

 PAPI_VASI – a simple box mounted on legs used in all PAPI/VASI configurations 

 Split - bi-directional light primarily for runway end applications 

 Strobe - strobe light mounted on a 5' pole  

 Strobe-T - strobe light mounted on a 30' tower  

 WigWag - typical wigwag with two alternately-blinking amber lights 
 
AFLT includes a least one base model in each category. As well, a surface-mount .mdl, 
Surface.mdl, i.e., a singe buried triangle (fulfilling the requirement for a surface to which 
things can be attached) used for lights element that do not include a 3D-model 
 
Elements on towers or supports may be set to any height.  The unneeded portion of the 
tower/support will be "buried". 
 
None of these models will cast shadows normally.  Custom shadows (provided - model 
file name suffixed with "_Shad") may be applied to all models except Approach_T.mdl, 
Beacon_T.mdl, Obstruction.mdl, Strobe.mdl and, Strobe-T.mdl.  Obstruction.mdl is 
generally used in locations where a shadow would add little realism.  In the other noted 
exceptions, a portion of the model usually will be buried but would still cast a shadow. 
 
BaseModels.txt includes four fields for each base model: 

 Name – calling name 

 Category –category in which the base model falls 

 m/f – indicates whether the following field  dimensions is feet or meters 

 Light Positions – the x/y/z position of each light relative to the models reference 
point.  A separate x/y/z position must be specified for each light source.  For 
example, for Splits and PAPI/VASIs, there must be two x/y/z positions. 

 
You may add to this set of base models or replace individual models.  Base models 
compiled for FS9 are saved in the BaseModels\FS9 folder.  Similarly, models compiled 
for FSX or P3D are saved to BaseModels\FSX and BaseModels\P3D respectively. It is 
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recommended you not change the names of stock elements.   If you do, or if you add 
new elements, you will have to add or edit the corresponding line in BaseModels.txt and 
Lights.txt.   

 
AFLT does not normally display a mounting base for lights on the surface.  But, as 
explained earlier under Option Menu, you may optionally configure AFLT to display such 
models   A .mdl file for such applications may be either 2D or 3D but, unlike other base 
models, need not contain an attachpoint.  These models are also held in the Base 
Models folder.  
 
AFLT ships with three models (actually 2D models with an image) for this use: 

 Surface_Omni.mdl - 8”/22cm diameter  for omni-directional applications 

 Surface_Bi_Small.mdl  - 8”/22cm diameter, primarily for centerline and runway 
end applications  

 Surface_Bi_Large.mdl  - 12”/30cm for applications where a larger bi-directional 
unit is needed, e.g., surface-mounted approach lights. 

 
If you add your own surface models, their file name must take the form 
“Surface_xxxxx.mdl”. 
 
Users who intend to create their own models are reminded that FlightSim interchanges 
the Y- and Z-axes and then inverts the Z-axis.  Models created with Flightsim 
gamepacks for Gmax and 3DS will comply with this convention.  Models developed with 
other tools must include the applicable transforms. 
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Appendix "B" - Colors.txt Format 
 

Colors.txt contols the displayed colors of all lights.  It provides the RGB value for 
BGL_LIGHTs and effects and the texture sheet offsets for LOD-Variable lights.  As well, 
it controls the displayed size of effects by color. 
 
AFLT supports six user-specifiable light colors: 

 amber 
 blue 
 dark (used for split lights on which only one side is illuminated) 
 green  
 red  
 white 
 

and five system colors: 

 BEACON 
 PAPI_RED 
 PAPI_WHITE 
 STROBE 
 WIGWAG 
 

Up to three “custom” colors may be added by the user.  All colors may be adjusted by 
the user as desired. 
 
Each color has the following attributes: 

 Name – the name by which the color is called 

 The brightest RGB value that can be used to display the color: 

 VERT (Bahr) coordinates on the LOD-Variable texture sheet Lights_Bahr.dds 

o Umin - X-value for the lower left-hand corner 
o Umax - X-value for the upper right-hand hand corner 
o Vmin - Y-value for the lower left-hand corner 
o Vmin - Y-value for the upper right-hand corner 

 Color Intensity Adjust – The RGB value above is for the maximum intensity of the 
color.  The displayed intensity of the color (not to be confused with the Lo/Med/Hi 
intensity setting of a light) will be the maximum intensity adjusted by this (%) 
value. 

 Effect Size Multiplier - Visibility differs between colors and, hence, affects the 
visible range of lights drawn with an effects. This item is used to automatically 
increase or decrease the “standard” size of effects, thus increasing or decreasing 
the range of the effect 

 Custom Effect Name – AFLT effects are named “fx_AFLT4_color _ 
characteristics.fx” and are regenerated whenever the data for a given FlightSim 
version is compiled.  If this field is not blank, AFLT will instead use the named 
effect.  Users must ensure an effect so named exists in the Effects folder of the 
relevant Flightsim version or, in the case of P3D, in the Effects folder of that 
version’s Documents “addon” folder. 
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Appendix "C" - Lights.txt Format 
 

Each line in Lights.txt applies to a specific model type, as follows: 
 
Column 1 -  Name 
 
Column 2 -  Name of base model used for this light 
 
Column 3 - True or False indication of whether the light is omni-directional 
 
Column 4 - Default horizontal spread of light(s) in degrees.  A blank entry implies full 

(360 degree) visibility.  No effect on omni-directional lights. 
 
Column 5 -  Default vertical spread of lights, centered about light tilt if any.  A blank 

entry implies full (90 degree) visibility. No effect on omni-directional lights 
 
Column 6-8  The size relative to AFLT’s default of medium intensity LOD-variable lights 

and lights whose source is mipped-effects and “standard” effects, 
respectively. That base size will be automatically adjusted + or – 25% to 
reflect the specified intensity of the light.  A relative size of 1.0 means that 
light will be drawn at AFLTs default size.  To make a light twice as large, 
specify the relative size as 2. 

 
Column 9-  The desired visible range (in nautical miles) of LOD-variable lights or, in the 

case of effects, a cut-off range. 
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 Appendix "D" – Light Characteristics 

 
AFLT supports four types of lights: 

 BGL_LIGHTs (FS9 and FSX only) 
 LOD-Variable lights (P3D only) 
 Standard effects 
 Inverse-mipmapped effects 

 
BGL_LIGHTs are very processing-efficient - more so than effects.  BGL_LIGHTs 
together with simple 3D models have a minimal affect on FPS.  However, the only 
control you have over the display of BGL_LIGHTs is their brightness – which is adjusted 
by varying the applicable RGB value in Colors.txt.  Their maximum range is sometimes a 
problem – particularly when used in VASI/PAPI applications. BGL_LIGHTs are rendered 
in FS9 only.  In FSX, a light element specified to use BGL_LIGHTs is rendered as an 
automatically-created effect the same color as specified for the BGL_LIGHT.  
BGL_LIGHTs cannot be used in P3D.  
 
LOD-Variable lights - not lights per se but, rather, they are brightly-colored simple 
models comprising 3 circular planes in the X, Y and Z axes.  They are designed so that 
their size varies inversely proportionally to Flightsim’s internal level of detail (LOD) of the 
model at any time, i.e., the lights are rendered at minimum size at LOD_100 and at 
maximum size at LOD_1.  This concept was pioneered by Christian Bahr.   Light size 
increases or decreases in small increments as the user aircraft moves towards or away 
from the light, so small that the change is not easily discernible.  These lights can be 
made visible up to 18 nautical miles (the distance at which Flightsim begins to discard 
scenery models) by adjusting the applicable LOD-Variable Max (size) entry in Lights.txt 
(see Appendix “C”).  The minimum size of each light is controlled by the LOD-Variable 
Min (size) entry 
 
It should be noted that LOD is calculated differently in P3D than in the earlier versions of 
Flightsim.  In P3D, LOD is calculated as a multiple of the model radius (RADI block in 
the .mdl file) whereas in the earlier versions of Flightsim, LOD is a function of the 
rendered object size relative to the vertical pixel count of the display window.  Thus, the 
maximum range may differ in each case.  So, you may need to use different size and 
range values to get consistent results across all Flightsim versions.  It can do no harm to 
experiment. 
 
Standard Effects may be used with any version of FlightSim.  However, due to the 
differences in handling across the various flightsim versions, it is unlikely that an effect 
created for one version can be used directly in another version.  Also, without special 
handling, the range of effects is relatively limited. 
 
To address these characteristics, AFLT uses a multi-emitter base effect whose critical 
parameter are adjusted on a per version basis.  The BaseEffect.fx file in the 
AFLT\Effects folder is a basic 3-emitter effect.  The first emitter is for close-up use and 
quickly fades.  The second emitter is somewhat larger, so, as the first emitter fades, it 
takes over.  The third emitter is for distance and is sized based on the desirable visible 
distance.  Unfortunately, even though its alpha value is as low as possible, its halo is still 
visible at close ranges.  But, this seems unavoidable.  On the up-side, with this approach 
the visible range of effects can be extended well beyond the typical 10,000m limit 
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Supplementing the base effect is the file AFLT\Effects\Control.txt.  It specifies the critical 
parameters for each emitter in the base and is structured such that a different effect may 
be specified for each lights type in each version. 
    
At the start of the file is a model type cross-reference.  For example, Edge lights are 
model type 1 and PAPI/VASIs are model type 5.  
  
Following this cross-reference are as many sections as needed to specify the full 
complement of effects across all Flightsim versions.  The structure of each section is: 

 File – the base effect file to be used (initially, BaseEffect.fx or 
BaseEffect_Mipped.fx). 

 Version - the Flightsim variant (FS9, FSX or P3D) followed by 0 or more model 
types separated by commas and preceded by “/”.  So “P3D/3,4” would apply to 
model types Approach and Approach_T in P3DV2 or later.  If no model types are 
specified, the parameters will be used for all model types for which a specific 
section has not been encountered.  Consequently, sections for those model 
types requiring special treatment must precede the default section for the 
Flightsim variant. 

 SizeMult – a size multiplier applied to the base size determined elsewhere.  One 
size multiplier must be specified for each emitter.  

 ColorDiv – the value by which the color RGB specified in colors.txt is to be 
divided to reduce the intensity of the color.  To avoid an overly bright halo close-
up, the final emitter, at least, usually requires a lower intensity 

 Alpha – the alpha value (1-255) to be applied to the color.  Normally, a high alpha 
would be used for the first emitter and a vey low value for the last to minimize its 
effect closeup. 

 Texture – the name of the texture for each emitter. Two stock textures are 
provided: AFLT_Additive.bmp and AFLT_Alpha.bmp.  As the names suggest, the 
first uses the Additive blending mode while the other uses the Alpha mode.  The 
blending mode is selected automatically, Additive being the default unless the 
texture name includes the character string “alpha”. 

 Face – The face value to be applied to all emitters in the effect. 
 
There must be one section applicable to every effect to be generated.  Otherwise, the 
base effect will not be modified and nothing will be displayed.  No warnings are 
generated. 
 
While initially thought to hold the most promise, inversely-mipmapped effects are only 
useable with FS9.  AFLT’s inversely-mipmapped effects are based on the single-emitter 
AFLT\Effects\BaseEffect_Mipped_FS9.fx.  To give some user flexibility, a similar 
customization approach to that used for their “standard” counterparts is implemented.  
The Flightsim version name is supplemented with “ Mipped”.  Face is unchanged.  The 
remaining parameters serve a similar purpose, but only for a single emitter.  Two 
textures are provided for inversely-mipmapped effects: AFLT_Mipped.bmp and 
AFLT_Mipped_PV.bmp, the latter being intended primarily for use with PAPI/VASIs. 
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Appendix “E” – Placements.xml Formats 
 
Placements.xml, found in each Project Folder, fully defines the lighting and associated 
3D model configuration for the associated airport. It holds a series of “strip” definitions ( 
a strip being a set of one or more associated lights), each strip containing one or more 
“placement” definitions for each such light.   
 
Airports, when decoded, become a set of “surfaces”, either a runway or taxiway link, 
referenced by a unique identifier, or an apron.  In the case of a runway, that identifier is 
the runway designator. For taxiway links, this identifier is the hyphenated starting and 
ending taxiway point IDs (from the airport reference file).  Each identifier is called a 
“surfaceRef”,  Aprons are for visual purposes only, so do not need a surfaceRef.   
 
A “strip” has two attributes: “surfaceRef” and a plain English “type”, and a series of 
parameters that apply to all placements: 

 flags:  0x3 - *Intensity mask 0x3 (low=1, med = 2, high = 3) 
 0xc - End Mask (Primary=0x4, Secondary 0x8)  
 0x10 - Dimensions are in feet (otherwise meters)  
 0x20 - *Lights on when pilot-controlled lighting triggered 
 0x40 - *Lights on when airport open 
 0x80 - *Lights at ground level 
            0x700 - *Scenery complexity mask 
 0x800 – Elevation of lights is AGL 

 config:  internal configuration name  

 modelNames: applicable base models, separated by “|”  

 params: No. of Towers (if applicable) 
 *No. of lights per tower 
 Spacing of towers (if applicable) 
 *Spacing of lights on tower 
 *Offset from runway end 
 *Offset form runway edge 
 *Offset from runway centerline 
 Length 
 Three additional parameters whose purpose varies with light type 
 
Each strip includes one or more placements, which has a single attribute, “params”.  
These “params” ( separated by “|”) - some of which may override a corresponding “strip” 
flag - are: 

 base model 
 *color(s) – must use system color names from colors.txt 
 flags:  0x3 - *Intensity mask 0x3 (low=1, med = 2, high = 3) 

 0x7C - Strobe sequence mask 
 0x80 -* PAPI/VASI on left side 
 0x800 - *suppress display of surface-mount image 
 0x1000 - *light at ground level 
 0x2000 - *elevation is AGL 
 0x4000 - *light is omni-directional 
 0x8000 - internal use 
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 *Latitude 
 *Longitude 
 *Slope 
 *Elevation 
 *Heading 
 *No. of lights 
 *Spacing of lights 

 
* May be edited by users.  Do not attempt to edit any item not so identified 
 
A reminder, the Placements.xml file can become unreadable due to something so 
insignificant as a missing or extra quote mark.  So, always make a backup before 
attempting to edit this file.  Otherwise, there is no way to recover lost data other 
than manual re-construction. 
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Appendix "F" - Standards.txt Format 

 
Each line in Standards.txt applies to a specific model type, as follows: 
 
Column 1 -  Name 

Column 2 -  Name of base model used for this light 

Column 3 -  Name of illumination texture for this standard 

Column 4 - Heading offset to have light-standard properly oriented (orientation of 
standard in .MDL file may not be appropriate) 

Column 5 - Ft./M. flag declaring units of following dimensional data 

Column 6 -  Head/Beam characteristics for each head separated by semi-colons 
(individual characteristics separated by forward slash): 

 X/Y/Z offset of head from the top of the standard 
 Default heading offset of beam 
 Default declination 
 Default beam width 
 Default beam height 

 
The procedure for adding new types of standards involved three steps: 

 create the base model; it may have any name; 
 save it to the Standards subfolders in the applicable BaseModels folder, similar 

to the procedure for a new base model; outlined in Appendix “A”; and 
 update  Standards.txt. 

 
You may also add new ground illumination colors for use with new or existing light 
standards.  A color file consists of a simple 256 x 256 pixel texture having the desired 
color and named either Iillum_Color_User_1.bmp or Iillum_Color_User_2.bmp saved to 
the Textures\Illum folder, replacing the stock file (copy of Illum_Color_White.bmp) 
already there. 


